Central Manager System

User’s Manual

V2.30
Content

1. PREFACE ................................................................................................................1
2. INSTALLATION ......................................................................................................2
  2-1. Install CMS .........................................................................................................3
3. PROFILE MANAGER ..............................................................................................5
  3-1. Create a New User Profile ..................................................................................5
  3-2. Delete Profile .....................................................................................................6
  3-3. Edit Profile .........................................................................................................7
  3-4. Import profile .....................................................................................................7
  3-5. Export Profile .....................................................................................................8
  3-6. Login ..................................................................................................................9
4. MAIN SCREEN .......................................................................................................10
  4-1 Main Screen .......................................................................................................11
  4-2 Display mode .....................................................................................................14
  4-3 Setup ..................................................................................................................15
  4-4 Snapshot .............................................................................................................34
  4-5 Full Screen .........................................................................................................35
  4-6 Event to Zoom ....................................................................................................35
  4-7 Playback ..............................................................................................................36
  4-8 E-MAP ...............................................................................................................41
  4-9 Quick Select Tag ...............................................................................................49
  4-10 Log System Status Window ............................................................................50
  4-11 Central Backup ...............................................................................................52
  4-12 Use Local Playback ........................................................................................60
5. APPENDIX .............................................................................................................63
  5-1. Maintenance .....................................................................................................63
  5-2. FAE Support ....................................................................................................63
1. Preface

Central Manager System is a powerful remote manager system. It can allow administrator to manage DVR systems through network located in different sites from one point of control.

Each CMS system can manage up to 64 sets with 1024 channels. You can monitor, playback, backup the DVRs’ video files through network at any time. You can also proceed to set up the remote system configurations.

With user friendly GUI, administrator can monitor the DVRs very easily.
2. Installation

CMS can serve up to 64 DVRs (1024 channels), Hybrid DVRs or NVRs at the same time. Before the installation, make sure your computer meets the following minimum requirement for connecting DVRs.

CMS supports DVR, Hybrid DVR and NVR firmware versions,

<table>
<thead>
<tr>
<th>Product</th>
<th>Product Firmware Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVR</td>
<td>V3.60, V3.81, V4.00, V4.20, V4.23, V5.00, V5.01, V5.02, V5.06, V5.20, V6.00, V6.20 and V6.30</td>
</tr>
<tr>
<td>Hybrid DVR</td>
<td>FV5.06, FV5.20, FV6.00, FV6.20 and FV6.30</td>
</tr>
<tr>
<td>NVR</td>
<td>NV5.06, NV5.20 NV6.00, NV6.20 and NV6.30</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CMS</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>VISTA</td>
</tr>
<tr>
<td></td>
<td>WinXP SP1/SP2/SP3</td>
</tr>
<tr>
<td>CPU</td>
<td>P4 2.8G above</td>
</tr>
<tr>
<td>Display Card</td>
<td>*Intel On-board VGA</td>
</tr>
<tr>
<td></td>
<td>*Nvidia – 7xxx series, 8xxx series VGA card</td>
</tr>
<tr>
<td></td>
<td><em>1024</em>768 screen resolution</td>
</tr>
<tr>
<td>RAM</td>
<td>512MB above</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>20 GB above</td>
</tr>
<tr>
<td>Network Card</td>
<td>10/100Mbs</td>
</tr>
<tr>
<td>Mouse</td>
<td>PS/2 or USB compatible</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>General</td>
</tr>
<tr>
<td>USB Interface</td>
<td>1.1 / 2.0</td>
</tr>
<tr>
<td>DirectX</td>
<td>V7.0 &amp; above</td>
</tr>
</tbody>
</table>

For connecting to DVR V5.10 and above versions, two hardware components should be upgraded as below,

<table>
<thead>
<tr>
<th>CMS200</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel Core 2 Duo E6300 1.86G and above</td>
</tr>
<tr>
<td>RAM</td>
<td>1G and above</td>
</tr>
</tbody>
</table>
2-1. Install CMS

Before you install CMS 2.30, please make sure if your PC system is already installed "Microsoft .Net framework 2.0". If not, please go to the following website "http://download.microsoft.com/download/5/6/7/567758a3-759e-473e-bf8f-52154438565a/dotnetfx.exe" and download "dotnetfx.exe" to your PC system. Execute this program and now you can start to install CMS200 V2.30.

1. Insert the installation CD.
2. Then go to the directory to run the Setup.exe and follow the steps. When finishing the setups, it will show up the message. Then, you can find the “Central Manager” folder and its sub menu from the Windows Start menu.

- Tools
  - Backup Information Tool
    From this tool, you can get the information of backup file. Please refer to the Chapter 4-11 Central Backup for the backup configuration.

  - Central Setup
    You can change CMS operation language in this menu.

CMS are running in Microsoft Windows platform. When you activate CMS, it will detect the Windows Language version and automatically switch CMS operation language with other language options according to the rule described in following table.
<table>
<thead>
<tr>
<th>Microsoft Window Language version</th>
<th>Default CMS Operation Language</th>
<th>Language Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>English</td>
<td>English</td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td>Traditional Chinese</td>
<td>English, Traditional Chinese</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>Simplified Chinese</td>
<td>English, Simplified Chinese</td>
</tr>
<tr>
<td>Japanese</td>
<td>Japanese</td>
<td>English, Japanese</td>
</tr>
<tr>
<td>French, German, Polish, Portuguese, Spanish, Dutch</td>
<td>English</td>
<td>French, German, Polish, Portuguese, Spanish, Dutch</td>
</tr>
</tbody>
</table>

**Central Backup:**
Central Backup function enables user to backup DVRs files remotely. Please refer to the Chapter 4-11 Central Backup for the backup configuration.

**Dvr Player:**
This is a local DVR player. After user downloads the DVR video files, he can play the files in this player in the Window platform. Please see the Chapter 4-12 User Local Playback.

**Emap Editor:**
CMS provides Emap function so that you can see the camera locations in the MAP. Before enabling this function, user needs to edit his own EMAPs in the Emap Editor. Please refer to the Chapter 4-8 EMAP Editor.

**Central Manager User Manual:**
You can access the user manual in this folder.

**Central Manager**
Click this icon to start CMS.
3. Profile Manager

After the installation, start the application by clicking the icon in the CMS folder from the Windows Start menu. The “Profile Manager” will show up to let the user to Create, Delete, Edit, Import, Export or Open “User Profile”.

First time to use CMS, user has to create a new “User Profile” to save the configuration of DVRs. You can create different Profiles for different configurations at the same time. Next time when you start the CMS, you don’t need to create a new User Profile any more and you just open one of Profile you prefer.

3-1. Create a New User Profile

Click “New” on the Profile Manager, it will show the Profile Setup Dialog as following
Key in the “Profile Name”, “Supervisor Password”(R/W Password), and “User Password”(Read only Password) in the Profile Setup Dialog.

After the new profile has been created successfully, the new profile icon will be shown on the Profile Manager screen as below. Refer to 3-1-6 to build a new profile.

Note

- “Profile” name can’t exceed 50 characters.
- “Profile name” only supports Chinese & English words and does not support special marks.
- Password can’t exceed 30 characters.
- Password only supports numbers & English character.

3-2. Delete Profile

If you want to delete the User Profile, click “Delete” button. Then, the system will
request you to enter the **Supervisor password**. Only supervisor has the authority to delete the **Profile**.

3-3. **Edit Profile**

If you want to edit the **Profile**, just select it and click the “**Edit**”. The system will request you to enter the **Supervisor** password. Only supervision has the authority to edit the **Profile**. Therefore, enter the **Supervisor** password.

3-4. **Import profile**

You can import the backup profile to system. It’s easy for copying the settings
between computers.

Click “Import” button, and select the *.b kp file which you want to import. *(the file you have exported before)*

![Image of Import Profile interface]

After importing file, the imported file will be added in the Profile Manager screen as following,

![Image of Profile Manager interface]

### 3-5. Export Profile

If you want to back up the profile or execute CMS on another computer but use the same profile, you can export the “Profile”.

Please choose the profile you want to export and click “Export” button.
The system will request you to enter “**Supervisor**” password. Enter the password and the address of the saved profile will show up. You can select the path to save the .bkp file which has just been exported, and it will appear on the appointed address.

### 3-6. Login

The user can choose the created **Profile**, enter the password and then start to login. There are two kinds of password identification—**Supervisor** and **User** password. Each one has different authority in CMS. The following is comparison tables of the authority.

<table>
<thead>
<tr>
<th></th>
<th>Profile Manager</th>
<th>Sequencer</th>
<th>Monitor Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New</td>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td><strong>Supervisor</strong></td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>×</td>
<td>×</td>
<td>×</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Quick Select Tag</th>
<th>Full Screen</th>
<th>Snapshot</th>
<th>Setup</th>
<th>System Status</th>
<th>Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Save</td>
<td>Delete</td>
<td>Rename</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Supervisor</strong></td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>
4. Main Screen

When you login the profile successfully, the following monitoring window will appear.
4-1 Main Screen

After finishing the DVR configuration (refer to 4-3 “DVR setup”), go back to Main Screen and it will show the following screen.

Click \( + \) button in front of the DVR in **DVR List window** and it will list all of the cameras connected to the DVR. Click any listed camera and the screen of this camera will be displayed in the “**Preview Window**”. You can decide if you want to display this camera in the Spilt Window. If yes, just click this camera, **Drag and Drop** it to any spilt window you want to display. You can also display all of the cameras in any DVR to monitor at a time. Just click the right button of mouse on any DVR in the **DVR List** and it will show the following menu. Select “**Add all**” and all of the cameras connected to this DVR will display to the monitor simultaneously.
4-1-1 Zoom in/ Zoom Out Adjustment
You can Zoom in or Zoom out any Spilt window. Double click on any split window and it will be enlarged to Full Display mode. You can double click again on this enlarged window and it will go back to the original split mode. In Full Display mode, you can enter [+ or -] to Zoom in or Zoom out the screen. There are ten display modes “Full, 250%, 225%, 200%, 175%, 150%, 125%, 100%, 75%, 50%”.

4-1-2 Camera Options
Click right button of mouse on any split window, the screen will pop up menu as below for camera options.

The following table is the description for each function.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>-Enable: Enable to display the camera in the Spilt Window</td>
</tr>
<tr>
<td></td>
<td>-Disable: Disable to display the camera in the Spilt Window</td>
</tr>
<tr>
<td>Sequencer Time</td>
<td>-Set up the Sequencer timer</td>
</tr>
<tr>
<td>Motion Detect</td>
<td>-Enable/Disable Motion Detection function.</td>
</tr>
</tbody>
</table>
4-1-3 PTZ Camera
If remote DVR has PTZ camera connection, the PTZ control panel will pop up when
the screen is displayed in **Full Display Mode**. PTZ controls include “Zoom In”,
“Zoom Out”, “Focus Near”, “Focus Far”, “Auto-Focus”, and “PTZ Speed”.

When user adjusts the PTZ control, it will not only change camera image but also
affects the recording result. CMS can support 128 preset points.

4-1-4 Minimize & Maximize CMS Window
By clicking the upper right button of the CMS window, you can minimize the
CMS window as the CMS icon showed in the bottom of Window desktop. You can click the icon to back to the CMS widow.
4-2 Display mode

There are 10 kinds of Split modes and 2 kinds of Sequencer modes in display mode. The Split modes include 4 splits, 6 splits, 8 splits, 9 splits, 10 splits, 13 splits, 16 splits, 25 splits, 36 splits, and 64 splits. The default option is 64 splits.

4-2-1 Sequencer Mode

CMS provides two kinds of Sequencer Modes, 1-channel and 4-channel Sequencer.

When you click Sequencer icon, it will show two options to let you select.

When you select 1-channel sequencer mode, the screen will display sequentially from cam 1 to cam 64. You can set up Camera sequencer timer according to 4-1-2 Camera Option. If any camera is disconnected, the sequencer will skip over it to the next connected camera channel.

If you want to exit the sequencer mode, you can press “ESC” or click to end the sequencer mode.
4-3 Setup

When you click the setup icon, you can see the following Setup menu.

4-3-1 DVR Setup

4-3-1-1 DVR Configuration
Click **DVR Setup** button to set up the DVRs that you want to control from remote CMS. Then, it will show the following screen.
Add remote DVR

Click **Add** button to add new DVR which you want to control from CMS. The system will appear a dialog box to prompt you to enter “DVR Name “, “IP Address”, “Port”, “Username”and “Password”.

The DVR’s Name shown in the CMS doesn’t need to be the same with the remote DVR’s name. That means CMS Supervisor can create a new name for DVR in the CMS site. In addition, Supervision also can name the new names for all cameras connected to the remote DVRs in the CMS site. All of these new names are just for CMS site and it won’t change the names in DVR site.

After finishing adding new DVRs, it will show the selected DVR information including connected cameras and DVR configuration when you point one of the DVR in the **DVR list**.

Besides, you can adjust network speed based on real speed status, just select “ 56K”, “128K”, “256K”, “384K”, “512K”, “768K”, “1M”, “1.5M”, ”2M”, “4M”, “8M” or “10M” for adjustment on the ComboBox. If you use company’s or school’s LAN, we suggest you can choose “ 10M” for quick display. For ADSL , Cable Modem , and Dial-up service , please adjust the setup based on real ISP speed.

You can also adjust the image quality, just select “low”, “Medium”, “High” modes for adjustment on the ComboBox .We suggest you choose “High” for higher image Quality. However higher quality will occupy more system resources, network
bandwidth, and it will result in low display speed. The setting of each Image quality:
* Low: 3 Kbytes/FPS
* Medium: 6 Kbytes/FPS
* High: 12 Kbytes/FPS

Each DVR has remote monitor function. If you want to execute remote monitor, please tick “Enable” in the . If you don’t need it, please just get rid of the “Enable” button.

After finishing the setup or modifications, click button to save the DVR changes.

- Delete Remote DVR
You can also delete any remote DVR controlled in CMS. Just select the DVR in “DVR List” which you want to delete and then click button.

- Refresh remote DVR
After modifying DVR configurations, you can click **Refresh** button to update the configurations. CMS will keep the latest setup status automatically. If there is any remote DVR disconnected, the system will show it as disconnected status in DVR List.

**DVR Remote Setup**

You can click Setup icon to have the remote DVR configuration in detail. However, you should verify if “Remote Setup” function in DVR site has been enabled. (Please refer to DVR user manual to “Enable” the “Remote Setup” function)

All of the remote setup functions are similar to the DVR system configurations.

When you click setup icon, it will show the following screen. You can have the “**Record Setup**”, Create or Edit “**User**” account, “DI/DO” setup, “Alarm Notice”, “System setting”, “Network status”, “Audio” and Environment”. 
Please refer to DVR **User Manual** to have detail setup for each items. After you finish the remote setup, click **Save To DVR** button and press **Back** button to exit the remote setup mode.

### 4-3-1-2 Alias Name

You can click the button of “Alias name” to set up Alias name for camera, DI and DO. After you key in alias name for each camera, DI and DO, click “Apply” to save the names that you have set up.

Set up Alias Name
20

4-3-1-3 Event Activation
CMS provides three kinds of alarm notifications, “Alarm Popup”, “Alarm Audio” and “Motion to Zoom” when the events are activated from Camera, DI and DO.

- **Camera Event configuration:**
  - Motion Detect:
    - Enabled
    - Motion to Zoom
- Alarm Popup Support
  - Motion
  - No Signal
  - Capture Fail
  - Ext Message Support
When there is a motion or no signal or capture fail event occurring, you can enable “Popup message” to remind “Administrator” there are events occurring.

You can define “Popup message” by yourself in “Ext Message column”, for example, contact information, address, etc.

- Alarm Audio Support
  - Motion
  - No Signal
  - Capture Fail
When there is a motion or no signal or capture fail event occurring, you can enable “Alarm to Audio” to remind “Administrator” there are events occurring.

You can define the music you want to play when the event occurs. Go to the “Environment Setup” (Please refer to the 4-3-2 CMS Environment Setup) and click “Alarm Audio” to set up the music you want to play for different event.

You can also set up the Alarm Mode. The alarm configuration are applied for “All event from DVR” or Current monitor camera”
- Save to Log
  - Motion
  - No Signal
  - Capture Fail

Save the event to Log so that Administrator can look up any time.

**DI/DO Event configuration:**
- Alarm Popup Support:
  - Enabled
    - Ext Message Support
- Save to Log
  - Enabled

When there is DI or DO event occurring, you can enable the “Alarm Popup message” and define the “Popup message.”
4-3-1-4 Sequencer
You can set up the display duration for individual camera.
4-3-2 CMS Environment Setup

When you click the setup icon, you can see the following Setup menu.

Click “CMS Environment Setup” to do CMS Environment Setup.
4-3-2-1 General Setting

- **DVR Connect--- Retry Times**
  You can set up **Retry Times** for DVR reconnection. If DVR is disconnected, CMS will try to reconnect to the remote DVR actively. The number of reconnection is the one you set in the “Retry Times.”

- **Frame Color**
  - Motion Detection: When motion occurs, the frame of the motion channel will be marked with the color you set up here.
  - 64 Channel Sequencer: In the 64 Channel Sequencer mode, the frame will be marked with the color you set up here.

- **Alarm Popup**
  Enable or disable “alarm popup” function.

4-3-2-2 Alarm Audio

You can set up playing different alarm audio when CMS receiving events from DVR including Motion detect, No Signal, Capture Fail and DVR Disconnect. The file format of alarm audio should be “.wav”.
4-3-2-3 Alarm Mode

You can set up CMS alarm popup and alarm audio triggered by “All events from DVR” or just by “Current Monitor Camera”.

4-3-2-4 SMS Notice

When CMS receives events from DVR, CMS sever can send SMS message to users via GSM Modem equipped in CMS server.
- **Enable:** Enable GSM alarm notice function.
- **Duration:** To avoid the duplicate alarm notices triggered from the same events, you can set the duration between 1st SMS message and the second SMS message for the same event.
- **Alarm Trigger Type:** You can individually set five DVR event types to trigger CMS server to send SMS message including “Camera Motion”, “Camera No Signal”, “System Warning”, “System Error” and “DI”.
- **Configure:** Set up the Baud Rate of the GSM Modem and the COM port connected to the CMS server.
- **To:** Set the mobile phone number that will receive SMS message. CMS server supports three phone numbers.

### 4-3-2-5 Alarm Notice

Before you activate “Event to Zoom” function, you should have the “Alarm Notice” configuration in CMS Environment setup menu. Please refer to Chapter 4-6 Event to Zoom.

1.) Click “Alarm Notice” tab to set up “Event to Zoom” function.
2.) Click “Add” button to add “Event to Zoom” rule and it will show the setting menu as below.

- Rule No: Automatically assigned by CMS
- Status: Enable Event rule
- Type: Event includes Camera Motion and DI(Alarm) Triggering. When CMS receives the notices of Motion or DI triggering from DVR, it will zoom in the alarm picture to the selected monitor according to the Event Rule.
- Interval: The interval that Rule is activated again by the same Event.

3.) After finishing the previous step and click “Next” step, it will show the detail Event Setting menu as below.

3-1. Camera Motion->Camera Zoom in
   If you set the Event type as “Camera Motion->Camera Zoom in” in previous step, it will pop up the menu as below.
DVR List: In the field of “DVR List”, select any DVR that CMS receive the Camera Motion notice from and will trigger “Event to Zoom” function.

Duration Time: Set the duration of zooming-in motion picture to the screen.

Camera Status column: Click any cell in the camera status column to enable DVR “Camera motion” to trigger zooming in selected camera motion picture to CMS selected monitor.

In the same Event rule, you can set motion cameras from different DVRs to trigger Zooming function. What you need to do is once you finish one DVR settings, you can select another DVR in the field of “DVR list” and repeat the step of enabling the selected camera status.

3-2. DI>Camera Zoom in

If you set the Event type as “DI->Camera Zoom in” in previous step, it will pop up the menu as below.
- **DVR List**: In the field of “DVR List”, select any DVR that CMS receive the alarm notice from and will trigger “Event to Zoom” function.

- **Duration Time**: Set the duration of zooming-in alarm picture to the screen.

- **DI/Camera Status table**: Click any cell in the DI/camera Status table to enable DVR “alarm (DI)” to trigger zooming in selected camera picture to CMS selected monitor.

In the same Event rule, you can set selected “alarm (DI)” to trigger zooming in selected camera picture from different DVRs. What you need to do is once you finish one DVR setting, you can select another DVR in the field of “DVR list” and repeat the step of enabling the selected DI/Camera status.

4.) **Assign the display monitor**: Then, you can set the display monitor for the triggered Event. Please refer to Chapter 4-3-3 “CMS Multiple Screen Setup”. When you click the field of “Screen ID”, it will show the CMS monitor list. Select any monitor for the Event rule and click “Ok” tab.

Then, you can see the Event Rule in the Rule List Window. Click any Rule in Rule List Window and the detail rule content will list in the Rule Content Window as below.
4-3-3 CMS Multiple Screen Setup

When you click the setup icon ![setup_icon], you can see the following Setup menu.

From CMS V2.00, it supports the function of multiple displays and the max number of display screens is 16. From the picture below, you can see that you just need to use one PC system running one CMS software but can display different CMS screens in different monitors. To make this function works, you need to install VGA card with multiple outputs. The number of outputs of the VGA card that you install depends on the number of monitors that you want to have.
Click “Multi-screen Setup” tab to start to set up Multiple Display function and it will show the window as below.

Click “Add monitor” and it will pop up a dialog box to let you set up the name of CMS applications which you want to display on the monitor.

Then, all of CMS application you add will be listed in the left column of the menu as
below.
By clicking any cell in the left column of the menu, you can assign the CMS application to the Monitor you installed. The number of monitors listed in the menu will depend on the VGA card you installed.

After you finish the multiple screen setup, you can see CMS applications displayed in multiple screens. Because each CMS application is independent, you can separately operate it to different mode according to your requirement.

Note:
We only support VGA card with Nvidia chipsets.
4-4 Snapshot

When clicking the left button of the mouse on the snapshot icon, you can capture the image of whole screen.

Click “Save” and it will show the following dialog box. Select the folder you want to save the Snapshot picture and click “Save”. The file is JPEG format.
4-5 Full Screen

Click the “Full Screen icon”\[\text{Image}\] you can enlarge any monitor to full screen. If you want to go back to main monitor screen, please press the “Space” to get back.

4-6 Event to Zoom

When Event to Zoom function is activated, the camera live image will be popped up to the CMS screen when CMS server detected the events from DVRs. By clicking the icon of “Event to Zoom”, it will show a menu for setting the Split modes of “Event to Zoom”. There are 1 single channel, 4- split and 8- split modes. Before you activate this function, you should have “Event to Zoom” configuration in CMS Environment Setup in advance. Please refer to Chapter 4-3-2-5 Alarm Notice.

When you click “8-split mode”, it means CMS can simultaneously show eight Events in the monitor. You can also click “Full Screen” icon to enlarge the Event Zooming picture to full screen.

If you want to let any event channel to keep displaying in the screen, you can click the right button of mouse on that channel and it will show a display setting menu as below. Click “Event to Zoom” and click “Lock”. The selected channel will keep to be displayed in the screen until you click “unlock” function.
4-7 Playback

If you want to see the recording video, click the playback button to see the following screen.
(1) Select a date on the calendar.

(2) Click button to select playback split mode. There are 1, 4 and 16 channel split modes.

(3) Click button to select the playback channels and it will show the following Window to let you to select the playback channels. You can individually tick the cameras that you want to playback. After selecting the playback channels, select the time slot of the video data that you want to play in the “Time Tree window. In the Time Tree Window”, it will list all of the time slots with recorded video files.

(4) Click to save the configuration and start to playback according to the new configuration.

(5) CMS V1.62 and above version supports playing the recording data recorded in the Daylight saving time. If the recording data recorded in the daylight saving time, it will be marked a star symbol in the right side.

[Event Search]
Besides searching the video data via time criteria, you can also search the video data according to DVR event criteria. The event search types include “System”, “Device” and “POS” events and you can refer to the definition of each event type in DVR User Manual.
(1) Step 1: Select Event Type: Include “All” event, System event, Device event or POS event.

(2) Step 2: Select Event Date: Select the Event date that you want to search the video data.

(3) Step 3: Set the pre-recording duration of the video data that you want to play.

(4) Step 4: Click “Search” icon to start the Search and all of the events met the search criteria will be listed in the search window.

(5) Step 5: You can click “Save” icon to save the event logs to a file as txt file format. Or you can select any event log and click “Playback” icon to start to play the video data of the selected event.

[Download Files]

Click button to download files and the following “Download Window” will appear. It will show all of the video files which are being played in playback main window for user to download. When you click different camera, the played file in this camera will be ticked. You can also click “Select None” or “Select All” to quickly select the download files. After finishing the selection, click button to start to download files or click to exit to playback main window.
[Snapshot]

Click button to show the **Snapshot Window**. If you don’t want to print or save certain picture, you just click on that channel to “Hide” the screen. You can click the channel again to “Show” the screen. Click button to print the snapshot pictures per channel per sheet by 320*240 resolution or click button to save the snapshot pictures as JPEG files.

[Definition of the Icons]

- **Rewind Speed ( - )**: To reduce the playback speed (0.5X, 0.2X and 0.1X).

- **Forward Speed ( + )**: To increase the playback speed (1.5X, 2.0X, 4X and 8X).
Playback

Previous 1 min: To rewind 1 minute.

Next 1 min: To forward 1 minute.

Pause

Stop

Playback event search

Select playback split mode (1, 4 and 16 channel split)

Save video clips (Download files)

Save JPEG files (Snapshot)

Enlarge to full screen

Adjust video size. There are 4 kinds of Zooming mode, 100%, 200%, Wide mode and Fit to Window.

Select playback channels.

[Minimize Playback Window]

By clicking the upper right button of the Playback window, you can minimize the Playback window as the Playback icon showed in the bottom of Window desktop. You can click the icon to back to the Playback widow.
Before you start to enable the EMAP function in CMS, you need to the EMaps in EMAP Editor. Click “Start” on your Windows taskbar, select “Programs” and then find the folder of “CenterManager”. In this folder, please click the “E-MAP Editor” to open the EMap editor and it will show the following dialog box.

Please select the CMS User Profile that you want to have EMAP function and enter the password to open the EMAP Editor (Only the administrator is authorized to create the E-MAP). Once you set up the EMAP profile in the EMAP Editor, you can start to use EMAP function in CMS manager. You just click EMAP icon in the CMS main menu.

4-8-1 EMAP Editor
When you successfully open the EMAP Editor, you can start to build your EMAP. EMAP Editor provides the functions that enable user to set up the locations of
Cameras in the E-Map to help the administrator to have the connection between camera and Map. The MAP supports hierarchy structure and can let administrator easy to manage the remote cameras and DVRs.

- **EMAP Format**
  - Map should support JPEG or BMP format.
  - The size of map should not exceed 1024*768.

- **Create EMAP**
  **Step 1 Load/Add EMAP:**
  Click “Add” icon to load MAP into the E-MAP Editor and it will show the following dialog box.
Click “Load” icon and it will show the following dialog box. Select the MAP you want to **Load** and click open.

![Open Dialog Box](image)

You can see the MAP in the Preview Window. Enter the MAP Name and click OK.

![Map Preview Window](image)

Then, you can see the MAP loaded into the EMAP Editor, the MAP name in the MAP List and Camera, DI and DO devices in DVR List Window.
Step 2 Add Cameras/DI/DO in the MAP

Click icons of “디지털 인터페이스” in front of the camera, DI and DO devices in DVR List Window and all of the devices connected to this DVR will be listed.

By “Dragging and Dropping” any camera, DI or DO icon from the DVR List window to the MAP and it will prompt the dialog box below to ask you to select the camera or DI/DO icon that will show on the MAP.

There are 8 camera direction types and you can select any type according to the direction you want to show in the MAP. If it is PTZ camera, you can select
You can also adjust camera location in the MAP by just dragging the camera icon in the place you want to put.

The camera, DI and DO devices put on the MAP will be listed in the MAP List Window. MAP List is managed in Tree View. You can click “Edit”, “Del” or “Add” button on the bottom of MAP list window to edit, delete or add MAP.
You can also click the left button of mouse on any MAP in MAP List window, it will pop up a menu as below,

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Move up the MAP</td>
</tr>
<tr>
<td>Down</td>
<td>Move down the MAP</td>
</tr>
<tr>
<td>Add</td>
<td>Add a new MAP under this MAP</td>
</tr>
<tr>
<td>Del</td>
<td>Delete MAP</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit MAP. You can edit MAP name or reload a new MAP.</td>
</tr>
<tr>
<td>Expand</td>
<td>List all of camera, DI or DO devices in this MAP</td>
</tr>
<tr>
<td>Collapse</td>
<td>Hide the list of the camera, DI or DO devices in this MAP</td>
</tr>
</tbody>
</table>

**Note**
- Camera, DI and DO icons shown in gray color mean that camera, DI and DO devices are not put in MAP yet.
- If you change the installation of DVR channels or alarm IO channels in DVR side during editing the E-MAP, you should be back to CMS main menu and do “Refresh connecting” by clicking right button of mouse to get update devices (Camera or Alarm device) shown on the E-Map Editor.
Step 3 Save the EMAP
Once you finish the EMAP configuration, please make sure to save the settings by clicking the “Save” in the “File” menu and click “Exit” to close the EMAP Editor.

4-8-2 EMAP Operation
After finishing EMAP configuration, please open and login to Central Manager system.

- Activate EMAP

Click the EMAP icon in the CMS to activate the EMAP function and you can see the following screen.
There are three statuses of cameras shown on the camera icons as below,

- (Event): DVR detects camera events of Motion, Mask or No signal.
- (Disconnect): Camera is disconnected.
- (Connecting): Camera is connecting.

You can directly click any camera icon shown on the MAP and CMS will immediately pop up a window to show that camera screen as below.

Click icon to snapshot the video screen. You can select “Print” to print the snapshot screen or select “Save” to save it as a file.

- EMAP in Full Screen

If you want to enlarge EMAP to full screen, just click full screen icon and the EMAP will be enlarged to Full screen as picture below. If you want to back to normal screen, just click the icon on the up-right side of MAP List window.
4-9 Quick Select Tag

User can define the configuration of Quick Select Tag from the ten options. It means that the selected split windows for each DVR and camera at any split mode can be saved for next time use. With this Quick Select Tag, you can switch to split window fastest and more convenient.

4-9-1 Save Quick Select Tag

You can save your own Quick Select Tag by clicking [Save]. Then, enter the name of the Quick Select Tag in the following dialog box. and press “OK” to finish saving.

![Quick Select Tag Dialog Box]

You also can select “Default View” in advance, and you can use the selected option whenever you initialize the CMS and Auto-Login.
4-9-2 Delete Quick Select Tag

If you want to remove the unnecessary selected options, please select the Quick Tag you want to delete on the combobox, and press **Delete** to delete the Tag.

4-9-3 Rename Quick Select Tag

You can click Rename icon **Rename** to rename the name of Quick Select Tag.

4-10 Log System Status Window

You can see the DVR status from the Log System Status Window.

- **Camera Event**: show the cameras with motion events.
- **Connecting Status**: show all DVR connecting status.
- **DVR Status**: show DVR status.
- **Channel Status**: show each channel status.
- **Connecting Log**: show each connecting log.
- **Log Search**: Search the event log

You can query the events according to time, event type, time, camera and DVR.

Set up Event type, Time, Camera and DVR and click **Go** to list all of the event logs which are within the conditions you set up.
Select one of the event log and click “Playback” to playback the video of this log which you query directly.
4-11 Central Backup

**CMS Central Backup** function enables administrator to back up local DVR files from remote side. Administrator just needs to select the camera, time and storage device and then can execute backup.

### 4-11-1 Execute Central Backup program

Click “Start” on your Windows taskbar, select “Programs” and then find the folder of “CenterManager”. In this folder, please click the “Central Backup” to execute backup program and it will show the following dialog box.

![Remote Backup Dialog Box](image)

- **Log in**
  Please select the CMS User Profile which you want to execute the backup. Because only administrator has the authority to back up DVR files, please open the User Profile by entering administrator’s password to login to the Central Backup.

### 4-11-2 Set up Backup Schedule

If DVR in the DVR list isn’t scheduled for backup, it will show “No Backup Schedule Setup” in the left window of “Backup DVR Information”.
Click “File>Backup Schedule Setup” in task list to start to arrange the DVR backup schedule. It will show the following dialog box. Select DVR you want to arrange the backup schedule and click “Modify schedule” in the left bottom of window.

Then, it will show the following window.

- **DVR File List**
  You can click each camera and it will spread all of the recorded files of each camera and show them by date.

- **Backup Camera**
  Select the cameras you want to back up.

- **Schedule**
There are two types of backup schedule. One is backup by “Once” and the other one is by “Periodical”.

- **Target Directory**
  Select the directory where you want to save the files. You can choose the directory of local HDD or the Network Drive.

- **Bandwidth Limit**
  Set up the maximum bandwidth of backup task. “0” means no limitation.

### 4-11-3 Functions in Task list
- **Action>Suspend**: Stop the backup task.
- **Action>Resume**: Restart the backup task.
- **Options>Bandwidth Limit**: Set up the limit of the total bandwidth and the maximum number of downloaded files at the same time.
- **Options>Alarm**: You can set up the HDD remaining size. When the remaining HDD space is smaller than the file size you set, the system will send an alarm audio to warn the administrator.
- **Options>Recycling**: You can set up the HDD recycling size. When the remaining HDD space is smaller than the size you set, the system will start to do the recycling.
- **Options>Login**: When power fails and you restart the system, it will login by using these setup values.
- **File>Files check**: This function provides you to check backup status.
(1) “Lost”: Check whether the files that you download are lost. If the files are lost, they will be recorded as “Lost”.
(2) “Not Found”: The file has been scheduled to be backed up and backup is not finished. However, you can’t find this file in DVR any more. Then, this file will be recorded as “Not Found”.
(3) “CRC Error”: The size of backup file is not the same as the one in DVR. Then, this file will be recorded as “CRC Error”.
(4) “Recycle”: Files are successfully backed up but these files are overwritten (Recycle) because the remaining HDD space is not enough. Then, this file will be recorded as “Recycle”.

After finishing the “Files check” and finding the incomplete files (Lost, Not Found, CRC Error), the system will show the following dialog box. User can decide to download these incomplete files again or ignore these files. If user decides to ignore these files, the system will not mark them as incomplete file any more when he executes “Files check” next time.
4-11-4 Backup Information

- DVR Backup status
  You can click any DVR in DVR list to see the total DVR backup status including backup settings, total backup files, backup size and remain sizes as the following picture.

- Camera Backup status
  Double click the DVR in the DVR list and it will list all of the cameras connected to this DVR. Click the camera and you can see the backup statistics of this camera as the following picture.
- **File Backup status**
  
  Double click the camera in the DVR list and it will list all of the dates with recorded files. Click any date and it will list all of the backup files in this date and the status of backup file.

  Double click any file in this backup file list and you can activate DVR player to play the file you backup directly. Click the right button of mouse on the file and it will show the directory where the file is saved.

  In the column of **Schedule Status**, you can see six types of file backup status.

  1. **Complete**: Complete the downloading file.
  2. **Incomplete**: File download is not completed.
  3. **Not Found**: File can’t be found in DVR.
  4. **Deleted**: Complete the file downloaded but file has been deleted by user.
  5. **GC**: File is downloaded but overwritten due to HDD recycling.
  6. **Wait**: File is not downloaded.

- **The state of DVR Backup task**

  In the bottom of window, it provides the various information including Backup Task “**Current Status**”, “**System Log**”, “**Connection Log**”, “**Storage Information**” and “**Network Statistic**”. 

  In the “**Current Status**” mode, there are 9 kinds of state in the column of “STATE” shown as following picture.
Task state

1. Sleep: It’s not the time to start the backup task.
2. Wait: It’s time to start the backup task but the number of total backup tasks is over the one you setting.
3. Download: Files are being downloaded.
4. Finish: Backup task has been finished but it doesn’t mean that all files are backed up. It is possible that some files are not backed up because they are overwritten due to DVR recycling.
5. Suspend: Stop the backup task.
6. Error: There is an error during the downloading files. Please check logs.
   After fixing the error, please restart this task.
7. Disk Full: Disk is full and can’t execute backup.
8. Disk Error: There is an unknown error happening in the disk. Please check the disk.
9. Empty: There is no file to be downloaded in the arranging schedule.

In the “Network Statistic” mode, it will show the current network flow as following picture. “Download Speed” is current average download speed. “Total Download” is calculating the total download file size. When you click “Reset Statistic” icon, the number of “Download Speed” and “Total Download” will be reset to “0”.

![Network Statistic](image)
Note
Bandwidth Limitation

- Individual task bandwidth can’t exceed total bandwidths.
- If all of the task bandwidths are set as “No Limit”, the tasks will averagely share the bandwidths.
- If the total task bandwidths are larger than total bandwidth, all of the tasks will share the total bandwidth according to the proportion.
- If not all of the task bandwidths are set as “No Limit”, the bandwidths will be assigned to the tasks that are already set in advance according to the proportion and then the rest of bandwidths are assigned to the tasks set as “No Limit”.

Others

- Backup log files are saved in the directory of CMS and named as “RBLog.mlb”.
4-12 Use Local Playback

In the playback mode, you can download the video files (Chapter 4-7-2) by clicking and save the files in the directory. The files you download are CX3 format. If you want to play the video file, you must execute “DVR Player” from Windows taskbar->Start-> Program-> CMS folder.

- Click the on the left down of the screen to open the video file and it will show the playing options as following,
  - Playback
  - Pause
  - Stop and go back the beginning of the film.

- **AVI Format Export:**
  This function provides you to transform the download files from CX3 format to AVI format.
  - Open a download file.
  - In the “Tools” bar, select “**Convert to AVI**” and then select the path you want to save the AVI file and key in the AVI file name.
Select the transforming format. Here we choose Microsoft MPEG 4 Video Codec.

Select transforming parameters and it will influence the file’s quality and size.
Enter “OK” and then it will show the transforming status.
5. Appendix

5-1. Maintenance

✔ Avoid placing the system at high temperature, high humidity, and also keep away from working in the frequent vibration environment.
✔ Operate the system under the conditions of stable and high voltage, If possible, the system should be equipped with UPS (Uninterruptible Power Supply).

5-2. FAE Support

For technical questions, please contact our Technical Support Team at 800-379-7226

*2. Our technical support representatives are available to support you 24/7.